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. USING THE MTPS TO VERIFY AND CORRECT THE
VTD/BBSP SUBMISSIONS

This Attachment provides specific instructions on the installation and use of the MTPS
for verifying and submitting corrections to Voting Districts (VTDs), State Legislative
Districts (SLDs), Congressional Districts (CDs) and Block Boundary Suggestions
(BBSP) to the Census Bureau.

Note: If not experienced with using the MTPS, it is critical to read this document in its
entirety, as the sections build upon each other and each step is important.

In February 2010, the Census Bureau delivers verification products to the state
participants for the VTD/BBSP. The verification products comprise the MTPS (Version
5.5)! and the Census Bureau provided shapefiles that reflect the processed and completed
updates inserted into the MTDB. In some cases they reflect changes already discussed
with the state and RCC staff. The Census Bureau delivers the VTD/BBSP verification
products on Digital Versatile Disk (DVD) to the participating states.

Depending on the computer and equipment, and the size of the state, installation of the
MTPS and the data can take up to 45 minutes.

The state data may be loaded into more than one computer or a local network server.
However, make sure that only one person is working on a county (or county equivalent)
at a time. Multiple data sets cannot be merged for the same county.

Also, since the MTPS is built on Maptitude it prevents more than one Maptitude session

from running at the same time. If a Maptitude session is open, close it before opening the
MTPS.

A. MTPS Installation
If the MTPS has not been previously installed, follow these steps:
1.  Start <Windows>.

2. Insert the Program DVD, the MAF/TIGER Partnership Software 2009, Version
5.5 into the DVD drive.

3. If the Installation Wizard does not automatically start up, choose the Run
command from the Start menu.

4.  Type the location of the DVD drive plus the word “setup” (for example, type
d:\setup), or use the Browse button to locate the setup.exe file on the DVD.

L MTPS v5.5 is now Vista compatible. This version no longer has Windows 98 compatibility.

Instructions for Using the MTPS for Verifying the VTD/BBSP Submission 4



10.

11.

12.

13.

14.

15.

Click OK. In a moment, the installation program will appear on the screen.
On the Welcome screen, click Next.
For Installation Type, choose Single User and click Next.

The setup program guides the user through the installation process, prompting
questions and providing suggestions along the way. It is best to accept the default
settings. The MTPS sets up a folder on the C drive called MTPS Data.

Once the program has been installed, the setup program indicates that Setup Needs
the Census Data and prompts to insert the 2010 Decennial Census, Redistricting
Data Program, Phase 2 — VTD/BBSP, (State), (State FIPS® code) DVD for the
state.

Insert the state data DVD and click OK.

After the state data files are copied, the installation process is complete and the
Setup is finished, click Finish.

Click the Start button on the Windows taskbar and from the Programs menu,
choose MAF-TIGER Partnership Software” and then MAF-TIGER
Partnership Software 5.5.

Click OK. This will display the Please Log In dialog box. Enter the User Name
as RDP? (case sensitive).

Click OK.

Then a prompt appears with two Startup Choices.

Startup Choices x|

— Startup Choices
™ Run the MAF/TIGER Partrership Software Computer Bazed Training

* Go directly to the MAFATIGER Partnership Software program

[~ Do rot show this dislog box again

Note: If not experienced with the operation of the MTPS, read through these procedures

and take the time to run the MTPS Computer Based Training (CBT).

2 Federal Information Processing System
® Redistricting Data Program

Instructions for Using the MTPS for Verifying the VTD/BBSP Submission 5



While operating in the MTPS, the CBT can be referred to by choosing Start (Windows
start button)-> Programs=> MAF-TIGER Partnership Software-> Computer Based
Training for MAF-TIGER Partnership Software.

B. VTD/BBSP Help

Review the on-line help for the VTD/BBSP program by choosing from the top menu,
Help—> Contents> MTPS Census Programs Help—=> VTD/BBSP. The Help menu
also provides instructions for various other topics. For instance, under Basic SKills learn
how to create layouts to use in documents or reports. This also provides information on
how to preview and make changes to a layout, edit and replace maps and dataviews, and
print a layout. The Help menu also includes an Index tab at the top to search a topic.

Note: To learn more about a command, dialog box, or toolbox, open or highlight the
item and press F1 to get the appropriate topic in the on-line help. To review the
function of an icon on any toolbox, hover the cursor over the icon and a text box
will appear describing the function.

C. Starting the MTPS and Selecting a County to Verify

Before opening the RDP.map window, a county (or county equivalent) must be picked to
verify. The MTPS then imports the data for that county. The MTPS is designed to work
on one county at a time. Each time the RDP.map map window is opened, it displays the
last county that was edited. To verify a different county, close the RDP.map window,
pick another county, and open the VTD/BBSP map window again.

To pick a County (or county equivalent) to verify, follow these steps:

1.  Choose from the menu bar at the top, VTD/BBSP-> Pick a County. The MTPS
displays the MTPS Counties dialog box.

2. Highlight a county in the scroll list.

MTPS Counties x|

— Pick a county

24003 - Anne Arundel County
24027 - Howard County
24033 - Prince George's County

3. Click OK.
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Before starting the import process, the MTPS displays a message recommending
that you disable any anti-virus software to speed the process. It is not necessary to
turn the anti-virus software off. Click OK.

Note x|
i MTPS is about to impart the data For vour area. Anti-virus software could slow down this process, Please disable any anti-virus software before
conkinuing,

4.  The software imports the county to work with.

status x|

Ewporting to DBD
ERRERENN 13%

5. Once the county’s import is complete, click OK to close the import window.

dote x|

L.l
w1 ) County "24027" was imported successfully, Please continue by choosing an option From the YTDYBESP menu.

D. Verifying the Selected County

1.  Choose VTD/BBSP-> Open.

File Edit Tools | YTOJ/EESP ‘Window Help
== | |' YT Toolbos:

BESP Toolbox

Line Editing Toolbo::

Area Editing Toolbox

Paoint Editing Toolbox:

Measuring Toolbosx

Suto-Coloring

Pick a County...

Find Mon-Conkiguous Areas
Find 2000 Feature Extensions
Cloze

Verify
Report Changes

Update User Information. ..
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The MTPS displays the VTD/BBSP map window.

2. If this is the first time running the VTD/BBSP module for a given county, the
software displays this box:

Area Settings: Yoting DisErick El

Settings

{* Start with existing features
" Create empty layer

" Impart Equivalency

0k, I Cancel I

For the verification process, Start with existing features displays the VTDs
submitted to the Census Bureau. Use this setting for verifying, correcting, and
updating the submitted VTDs.

Important Note: Do not select the Create empty layer radio button setting.
This resets the submitted VTD layer to ‘“*scratch’.)

After selecting Start with existing features, click OK.

3. The file opens with the RDP.map and the Standard toolbar across the top of the
screen.

MAF/TIGER Partnership Software
File Edit Map Dataview 3Selection Tools YTD/EESP Window Help

EETNE EEIEEREEL AR T

RDP.map - RDP 5T24 24035

,I* ‘ 8

01001

!
a Barcl . town
=, T

* dae®

c .,
AT, & ose

.y -
DISTRICT 4, GHAPEL
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Note: The MTPS applies colors to the VTDs. If necessary, adjust the color
scheme with the Map—> Coloring box. This changes the “scheme”. A
specific color for a specific VTD can not be set.

4.  The MTPS opens the Tools, and the VTD Editing toolboxes, and the Map layers

legend.
£
@ &% #F o] ¥ ¥
Edit Layer I"u-"-:-ting Chztrict ;I
| T arget Area INEW Dristrict ;I
'&l a " | R Source Area I.-“—‘-.II ;I
i ) g @I | (L E@ | Selection Laper IFaces ;I

Map layers
B WTD
e Brea Landmark
River, Lake, ar Ocean

[ |Faces

— &l Lines

Census Tract
2 e MCD
CoLnty

B state

s+ 3+ Incorporated Place
L5 % Census Designated Place
Unified SD (Statewide)
WTD 2000 (Statewide)
B e Current SLD Lower (Statewide)
Current SLD Upper (Statewide)
Area Landmarks
Area Landrnark: Park
Area Landrmark: Military
e Brea Landmark: Other
Type of Line
Primary Road
—— Secondary Road
Meighborhood Road
Other Roads
~—— R ailroad
—— Ground Transportation
—— Landmark
Phiysical feature
------ MNon-visible feature

StrearnShoreline

0 10,000
| ]

Feet
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The Map layers legend shows which layers are displayed. The default setting
shows all layers in the MTPS except Census 2000 blocks, block groups, SLDs, and

CDs.

Note: To learn more about a command, dialog box, or toolbox, open or highlight the
item and press F1 to get the appropriate topic in the on-line help. To review the
function of an icon on any toolbox, hover the cursor over the icon and a text box
appears describing the function.

Note: The session continuously saves while working and saves when closing the county.

E. The Tools Toolbox

A

CUCRVNIE N

O & | mi |
Use the tools on the Tools toolbox to move around the map and change the map scale, as
follows:
To do this... Do this...

Zoom In to a point or a rectangle

Zoom Out from a point or a rectangle

Move the map in any direction

Return to the Previous Scale and center

Return to the Initial Scale and center

Click g on the Tools toolbar and click on a point or drag a
rectangle. The MTPS increases the scale and changes the center of
the map.

Click g on the Tools toolbar and click on a point or drag a
rectangle. The MTPS makes the scale smaller and changes the center
of the map.

Click ﬁ on the Tools toolbar and drag the map. The MTPS
changes the center of the map.

Choose, from the top menu bar Map->Previous Scale or click ﬂ
on the Tools toolbar.

Choose, from the top menu bar Map-> Initial Scale or click 1% on
the Tools toolbar.
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Use the Info tool to see the attributes for a layer, as follows:

To do this...

Do this...

Change the working layer

Get information on a map feature

Get information on several features

Get information on several layers

Get information on area layers

Measure distance between points

Measure the size of an area

Change the fields that are displayed

Close the Info window

Choose the layer dropdown list on the Standard toolbar for the
working layer.

Click ﬂ on the Tools toolbar to activate the Info tool and click on a
feature on the map. The MTPS marks the feature with an i and
displays the data for the feature in the Info window.

Click g on the Tools toolbar to activate the Info tool and drag a
circle around the map features. The MTPS marks the features with
an i and displays the data for the features in the Info window.

Click @ on the Tools toolbar to activate the Multi-Layer
Information tool. Click at a location on the map. The MTPS
displays the Multi-Layer Information tool, and shows the
information for the first feature in the first layer. Make choices as
follows:

Click *@I on the Tools toolbar to activate the Multi-Layer Area
Information tool. Click at a location on the map. The MTPS
displays the Multi-Layer Area Information tool, and shows the
information for the features in the chosen area layers.

3

click E= on the Tools toolbar to activate the Measure Distance
tool. Click on the map at the starting point. The MTPS starts a line
at the point clicked. The MTPS displays the elapsed length in feet of
the line in the status bar at the bottom of the screen. If the line to
measure is not straight, click on one or more shape points along the
line. The MTPS continues the measurement through each shape
point. Double-click on the last point to end the line measurement.
The MTPS displays the total length in feet of the line in a Note dialog
box. Click OK to close the dialog box.

Click E@ on the Tools toolbar to activate the Measure Size tool.

e Click on the map at the starting point of the area. MTPS
starts a line at the point marked.

e  Click on the corners of the area. MTPS continues the line
through each one.

e Double-click to end the area. MTPS connects the first and last
point automatically. MTPS displays the size of the area (in
map units and acres) and its perimeter (in map units) in a
Note dialog box.

e Click OK to close the dialog box.

Right click on the Info window and choose Field Sets, highlight an
existing set or click Add to create a new set, and click OK. The
MTPS displays just the fields in the field set, in the order chosen.

Click the Close box in the upper right corner.
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F. The Layers Menu

x|

Lavers in Order of Dizplay Sample Statuz

Cloze

Area Landrnark s Autoscale
Fiiver, Lake, or Ocean Autoscale MI
Faces ] Autozcale Add Layer
Maode * Hidden —_—
. Drop Layer
A Lines 24003 e Autozcale —_—
Cenzus Block 2000 SOCE Hidden bove Up
Cenzus Block Autozcale boree D owr
Mersns Black Rooon rUt Hiddr+ LI

Style... | Labels. .. | .ﬁ.utuscale...l tetadata I

Gengraphic File |E:'\MTF’SData'\E#DﬂWuting Digtrict. DBD

Engage the map Layers menu E=; on the Standard toolbar across the top of the screen
to see the map layers and their settings, as follows:

Turn map layers on or off depending on what to display on the map. For example, if
VTDs have nothing in common with school districts, there is no need to display them and
thus turn that layer off (Hide Layer). If reviewing SLDs or CDs to ensure that any
relationships with other governmental entities are intact, turn those respective layers on
(Show Layer).

Note: The first item listed in the Layers in Order of Display column, VTD, is the first
layer drawn on the map. The remaining layers are drawn sequentially, with each
added layer being drawn on top of the previous one.
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To do this...

Do this...

Open the Layers dialog box

Choose a layer

Hide a layer

Add a layer

Drop a layer

Change the order of the layers

Change the style settings for a layer

Change the label settings for a layer

Change the autoscale settings for a layer

Close the Layers dialog box

Choose Map-> Layers or click % on the Standard toolbar, or
right-click on the map window and choose Layers. The MTPS
displays the Layers dialog box.

Within the Layers dialog box, highlight the layer in the scroll list.
This list shows the layers in the order drawn, a sample of the style,
and the status.

e  Hidden means the layer does not draw.

e  Autoscale means the layer draws between certain scales.

e Blank means the layer draws at all scales. Also hold the
Shift key and click on another layer to highlight a range of
layers, or hold the Ctrl key and click on a layer to toggle the
highlight on or off and select multiple layers.

Click Hide Layer. The button changes to Show Layer to reshow the
layer. The layer’s status changes to Hidden.

Click Add Layer to display the File Open dialog box. Choose the
type of file and one or more files to open. Click Cancel to close the
dialog box without adding any layers.

Click Drop Layer. The MTPS displays a Confirm dialog box.
Click Cancel to close the dialog box without dropping the layer.

Caution: Only drop layers that (you) have imported from (your)
own shapefile. If it is not desired to see a layer that is included in the
MTPS, just Hide the layer.

Click Move Up or Move Down. The MTPS moves the highlighted
layer up or down.

Click Style to display the Style dialog box, which is different for
point, line, and area layers. Choose different styles from the
dropdown settings. Selections are illustrated in the box to the right of
the settings. Click Apply to try out changes to style settings, but
click Cancel to close the dialog box without changing the settings.
To save these settings, click OK.

Click Labels to display the Automatic Labels dialog box. Click
Apply to try out changes to label settings, but click Cancel to close
the dialog box without changing the settings. To save these settings,
click OK.

Click Autoscale to display the Autoscale dialog box. The largest
dropdown list, if not blank, shows the largest scale at which to
display the layer zooming in. The smallest dropdown list, if not
blank, shows the smallest scale at which to display the layer zooming
out. Click Cancel to close the dialog box without changing the
settings.

Click Close.

Note: The MTPS labeling engine places the labels on the center of the district. If the
center of the district itself is outside of the district itself (as in a crescent shaped
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district) the label is attached to the edge nearest to the center point. The labels are
static when zooming in or out and panning.

The labeling engine makes a determination of which labels to draw and which to
suppress when the drawing of all the labels would cause them to overlap. If it is
zoomed into where the individual blocks are being labeled, this suppresses the
VTD labels in some areas where drawing them forces an overlapping label. To
see the VTD labels only, turn off the block labels. As long as no other area or
feature labels overlap, the VTD labels should then appear.

G. Reviewing the VTD/BBSP Submission

For reviewing VTDs, select Voting District as the Edit Layer. For reviewing other
RDP entities, select SLD Lower, SLD Upper, or Congressional District in the Edit
Layer for reviewing these RDP districts.

This section focuses on the review of the VTDs. Review and verify the VTD Code,

Name,

Note:

Note:

Fe vwocsd Rl

JEEHE r i

and the boundaries.

Turn off or hide the water layer in the Map layers dialog box when viewing VTD
coverage because that layer appears on top of the VTD layer, making it difficult
to view the VTD coverage.

Hover cursor over any area to identify the VTD. A text box appears with the
VTD Name.

12

&
[
£l _ "’
L fiamey Planigtion Rd
P L .

5 1 AoH
)

Bk Holky ot

m—— fT‘v‘TD Clugen Anne's Precinct 04-003]
B _==. :%!-
! s 2

K ¥ ] ]
£ =,

= 0448403

Plantation Ly

For more info about the VTD, select IE and click an area. The Dataviewl -VVTD Info
appears.
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_iBix
MHAME| Queen Anne's F'recinu:tl ﬂ :
I 7
Area 34E834880.00
[ oting Diztrict] 04-003 A
STATEFPOO 24
COUMTYFPOO0 035
WTDSTOO 04-003
MAMELSAD| Queen Anne's Precinct
YTl A
LSa 1] ;
CHMG_TYPE B
EFF_DATE
HEW _MakE
MHEw_CODE
RELTYPE1
RELTYFEZ
RELT*PE3
RELTYPE4
RELTYFES
REL_EMT1 ;I
OCI ChIT

Verify that the following elements are correct:

e Verify that the VTD codes (ranging from 1-6 alphanumeric characters) are
correct. The Code may include dashes, dots, or forward slashes.

e Verify that the VTD names are correct. If a Name is not provided in the
submission, the Census Bureau uses the VTD Code as the Name.

Note: Names can be up to 100 characters, including alphanumeric, spaces
(consecutive spaces not allowed) and all special characters. If a VTD
Name uses all 100 characters, the Census Bureau does not add the words
“Voting District” after the name. Adding the “Voting District” character
string is too long in these cases. This is accomplished by assigning a
Legal Statistical Area Description (LSAD) code of “00”. (See a full
description of the LSADS on an upcoming page.) Codes and names
should be consistent and should be reviewed for spelling accuracy,
keeping in mind that these names will appear in public products.

Note: If any area was submitted with unassigned areas (uncoded faces?), the
Census Bureau assigns the code of ZZZZZZ to these unassigned areas.
These are identified as Voting Districts not defined which appear in the
American FactFinder and the P.L. summary files. This ensures that the
Census Bureau has accounted for all faces in the county.

* Faces is the MTPS term for polygon.
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e Verify that the VTD boundary is correct and where relevant, is following the
correct visible or non-visible feature. These features may be geographic entity
boundaries such as township and incorporated place boundaries, or visible
features such as roads or water features.

Note: If a VTD follows a township or incorporated place limit that has moved,
adjust the VTD to the new township or corporate limit. The Census
Bureau only maintains whole entity relationships as described in the
Relationship Information Review document.

Note: At any time during the review and verification, a list can be reviewed of
all submitted VTDs. With the VTD Editing toolbox open, generate this
VTD inventory file for all current VTD codes and associated names by
selecting VTD from the dropdown menu on the Standard toolbar.

" MAF/TIGER Partnership Software
File Edit Map Dataview Selection Tools MTDYEESP  Window Help

=5 & 9 [0 s I EEEE R AT

' RDP.map - RDP 5T24 24035

L TBT i i T
CF Maina DS .

Then click the New Dataview icon 2. The Dataview2 — VTD table appears.

ol
gnfafs ID| Area|[Voting District] [STATEFPOD|COUNTYFPOD[VTDSTOD |NAMELSAD
1 1994539264.00 01-001 24 035 01-001  Queen Anne's Precinct 01-001
10 1557806208.00 06-001 M 035 06001  Queen Anne's Precinct 06-001
2 1297716736.00 02-001 2 035 02001  Queen Anne's Precinct 02-001
1 919491712.00 07-001 2 035 07001  Queen Anne's Precinct 07-001
12 3803255552.00 24 035 777777  Voting Districts not defined
3 173693504.00 02-002 M 035 02002  Queen Anne's Precinct 02-002
4 2050061824.00 03-001 2 035 03-001  Queen Anne's Precinct 03-001
8 1151012864.00 05-001 2 035 05001  Queen Anne's Precinct 05-001
6 225299696.00 04-002 24 035 04-002  Queen Anne's Precinct 04-002
g7 346834880.00 04-003 M 035 04-003  Queen Anne's Precinct 04-003
9 390965184.00 05-002 2 035 05002  Queen Anne's Precinct 05-002
£ 13 316384512.00 2 035
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Note the VTDI and LSAD fields in the Dataview table:

Es £ Eu VTDI  |LSAD
A 00
00
00
00
00
00
00
00 B
00
00 B
00

|CHNG_TYPE [EFF_DATE [NEW_NAME

= - = - iy = - - -

e VTD1: This stands for Voting District Indicator. A = Actual; P =
Pseudo.

An A = Actual VTD is one that exactly matches the VTD (election
precinct, ward or other election area) boundary in the state. If the VTD
does not reflect the actual election VTD boundaries, the state may
designate P = Pseudo.

Note: If the state does not designate the VTD1, the Census Bureau
designates P = Pseudo for the requisite VTD.

e LSAD: This stands for Legal Statistical Area Description. These codes
determine the way the names of some entities appear in products.

V1 = “Voting District” is the prefix to the VTD Name. For example,
if VTD Name is “5”, the NAMELSAD = Voting District 5.

V2 ="Voting District" is the suffix to the VTD Name. For example,
if VTD Name = “Albemarle”, the NAMELSAD = Albemarle
Voting District.

00 = no prefix or suffix to the VTD Name. For example, if VTD
Name is “Queen Anne’s Precinct 01-001”, the NAMELSAD =
Queen Anne’s Precinct 01-001.
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H. The VTD Editing Toolbox

®|@|@|§%l 5 1% o] ¥ !l
Edit Layer I"-.-"u:utlng Dristrict
Target Area IEI# 004 Queen Anne's F'reu:_l
Source Area I.-’-'-.II j
Selection Laper IFaces j

All VTD editing and corrections required for boundaries and line work are performed
using the VTD Editing toolbox. The dropdown selections in the VTD Editing toolbox
are:

e Edit Layer: The layer to edit (the layer to correct or update; Voting District,
SLD Lower, SLD Upper, or Congressional District)

e Target Area: The area to edit, either editing a New District, a submitted
<existing> district, or Unassigned area. For verification, typically an <existing>
district is corrected. Selecting New District is for adding a new VTD.

e Source Area: The areas from which to select, either editing All areas, an
<existing> district, or Unassigned area. Typically All is selected for the Source
Area. Selecting an <existing> area for the Source Area restricts the designated
Target Area to only those faces in the selected <existing> Source Area.

e Selection Layer: Faces, or a specific geographic entity. The layer from which
to select. Typically select Faces. If the VTD is coextensive with a specific
incorporated place or (other geographic entity), select Incorporated Place and
place the cursor in the respective incorporated place to add this area to the Target
Area VTD).

Note: There should not be any Unassigned VTD area (faces) in verifying the
submission. The submission is checked and validated for any area(s) not assigned
to a VTID. The RCC may have consulted the state participant regarding any
unassigned faces for a VTD and solicited guidance on what the VTD assignment
should be. Ultimately, for areas that were not assigned a VTD code, the Census
Bureau enters the ZZZZZZ code as previously mentioned.

Follow these steps for editing and correcting a VTD using the VTD Editing toolbox.
1. Choose a layer from the Edit Layer dropdown list in the VTD Editing toolbox.

Selections are Voting District for correcting or viewing submitted VTDs, SLD
Lower (SLDL), SLD Upper (SLDU), or Congressional District.
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2. Choose a Target Area. The Target Area is the VTD (or other RDP entity) to
correct.
To do this... Do this...
Pick the target area in the toolbox Choose a target area from the Target Area dropdown list
OR
Pick the target area on the map Click and click in an area on the map
Create a new target area Choose New District from the Target Area dropdown list
The MTPS makes the area selected the Target Area and shades it on the map. If
the “water” layer is turned on and there is water in the area, the water is displayed
instead of the shading. Hide the “water” layer at this point.

3. Use the following buttons in the VTD Editing for navigation:

To zoom to...

Do this...

An existing target area

The entire map

Click @ The MTPS zooms in the map so that the whole target area
is visible. Zooming to the target area cannot be done if New District
in the Target Area is selected in the dropdown list.

Click @ The MTPS zooms to show the entire map.

Note: Also use the Tools toolbox to navigate around the map.

4. Toedit the Target Area VTD:

To do this...

Do this...

Update target area attributes

Delete all work in the county

Choose areas to create a VTD

Unselect a face

Click @ to display the Attributes dialog box. Make updates as
necessary.

Click EI

Click ﬁl to select one or more areas, or click and drag a rectangle
around areas to select them. The entire polygon or face must be
within the rectangle or shape in order to be included. This is used
when creating an entirely new VTD from what was submitted.

Hold the <Ctrl> key while using the pointer tool (above) on the face.

This will unselect it. Select areas by shape. Click El to select
areas within a shape, then click on the map and move mouse and
click again until all the areas to select are inside the shape. Double
click to end. The entire polygon or face must be within the rectangle
or shape in order to be included. Save work on current action. Click

B
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Undo work on current action Click =

Undo work on current action From the menu selections across the top of the Standard Toolbar,
select Edit, Undo. It starts with undoing whatever has been
committed or saved. A pop up box prompts to continue undoing
area or line edit. Then it goes backwards until it reaches the end of
everything saved or committed during that session. Once closing the
file, the Undo is no longer functional.

Note: Use the @ Select by pointing from an area layer tool to select one or
more areas or the ﬂ Select by shape from an area layer tool to select
areas within a shape. Using the @ Select by pointing from an area layer
tool, click on one or more areas, or click and drag a rectangle around areas
to select them. Hold the Ctrl key and click on selected areas to remove
them from the selection.

Use the E Select by shape from an area layer tool when drawing the
“fence” or “lasso” around the desired selected area adding area of the
Target Area VTD, click at each point and left double-click to complete the
“fence.” This selected area is highlighted. Use care to not include an
inadvertent face in the “fence” or ”lasso”.

To remove the selected area during this VTD modification session, click

¥
5. To edit the Relationships for the VTD:

Edit relationships created during verification or add relationships in the Voting
District Attributes dialog box as follows:

To do this... Do this...

To create a relationship Click ﬂ choose a relationship type from the Relationship
dropdown list, choose an entity type from the Entity Type dropdown
list, and select a FIPS code from the FIPS Code dropdown list.

To find the name that matches the listed FIPS code: From the
dropdown menu on the Standard toolbar, select Incorporated Place

and click on the Dataview icon.

To remove a relationship Highlight the relationship and click ﬂ

To add other relationships Type the relationships in the Other Relationships dialog box, using
the abbreviations CC for completely contains, WW for wholly
within, CO for coextensive.
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Yoting Districk Attributes x|

— General

Code IEId-EIEId v Pseudo

MHame |Dueen Anne's Precinct 04-004

— Relationzhipz

Relationship Entit_l,l T_I,Ipe FIPS Code

W holly Safithin

#[x]

Other Relationzhip

Mate: these uzer-defined relationzhips are for the Cenzus Bureau's infarmation only and do not
have any validation or enforcement capabilities in the MTPS zaftware.

Cancel |

Click OK.
The MTPS saves the attributes.

To edit Relationships created during verification for an existing VTD, select the
Display Area Data from VTD Editing toolbox. The Voting Districts Attributes
dialog box opens and there you can edit Relationships.

¥1D Edltlng
m|@ | BE)F 2 o] ¥ _Ii
Edit Layer [Waoting District
T arget Area |EI1 001 Queen Anne's F'reu:_l
Source Area IEIE-I:IEI'I [ueen Anne's F'reu:LI
Selection Layer IFaces ;I

See the Relationship Information Review document included on the Data DVD for
reporting relationship information.

I. Correcting VTDs Using a Layer From a Local Database as the
Source

Some states maintain a VTD layer in their own Geographic Information System (GIS)

software. The MTPS allows participants to import these files (some of which are
compiled from the Census Bureau supplied data shapefiles) and use them to review and
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verify VTDs. To import this correction data from the local GIS and create a new layer in
the MTPS, perform the following steps:

1. To repeat, if this is the first time running the VTD/BBSP module for a given
county, the software displays this box:

Area Settings: Yoting Dis

X

Sethings

{* Start with existing features

" Create empty layer

= Import Equivalency

ok |

Cancel I

2. Again, for the verification process, Start with existing features displays the VTDs

submitted to the Census Bureau.

updating the submitted VTDs.

Important Note:

Use this setting for verifying, correcting, and

Do not select the Create empty layer radio button setting.

This resets the submitted VTD layer to “scratch™.)

After selecting Start with existing features, click OK.

3. Select@ Map Layers icon.

4.  From the Layers dialog box, select Add Layer.

Layers NS
Laverz in Order af Dizplay Sample Status
Current SLD Loweer [St... " Hidden ;I
Current SLD Upper [St... Hidden
Current CO [Statewide) Hidden
SLD Lower L Hidden
SLD Upper i Hidden
Congreszional Digtnict 0 Hidden
Poirt Landmark, * Autoscale

Style. .. | Labelz... | .ﬁ.utnscale...l

Cloze

1%

Hide Layer

Dirop Layer

bove Up

f e Do

tletadata

L

Geographic File | C:AMTPSDatah 240355 ating Distrct. DED
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5. From the File open box, select the File name and Files of Type and click Open.

2|
Lock in: | ) VTD-BBSP x| « @Bk E-

Final Files

Submission Received

Yerification Procedures

YTD_EBBSP_Returned_to_HQ
. rdp 9 =ldl_w20,shp

#]rdp_2009_39_sldu_+v90.shp
#]rdp_2009_18003_vtd_v90.shp
%] rdp_2003_39049_county_vo0.shp

bl
D oz

File name: [1dn_2009_39_sidl_v30.shp -
Files of type: |ESRI Shapefile [*.shp) = Cancel |

[ Open az read-only ¥ Open for exclusive access

6. The ESRI shapefile dialog box opens, click Coordinates.

x
File |E:"~D ocurments and Settingshbele0007 40 Ok I
Werzion | 1000 Cancel I

E xtent | [-84.8203065,38.403423)-80.518454 42 3271 32]

Type |F'|:|I_I,Ig|:-n I Coordinates I

Layer Mame |rd|:-_2IZIEIE|_SEI_SIdI_vE|D

[T Import ayer
¥ Eliminate duplicate boundany lines

|F areas overlap
% hierge the overlap with one of them
" Create a new area
! [ aintain overlapping areas
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7. Set Datum Conversion if necessary, to NAD 83. For example, if the local
shapefile is USA NAD 27, select USA: NAD 27 to USA NAD 83 and click OK.

Import Coordinates x|
— Linear Transformation
Type I Mone ;I

| Mo Lingar Transformation Selected

— Coordinate System

Clazz ILDngitude, Latitude

=l
Zone I ;I

— Unit Conversion - Interpret A
[ pite ll

- Datunn Conversion

— Optian
¥ Split Links/dreas at the -180/180 Degree Median

Reset | Cancel |

8.  Now click OK to the ESRI Shapefile menu.

x
File |I::"-.D|:u:ument$ and 5 ettingzibyle0007 40 I (1] Il
Werzion |'IEIEIEI Cancel I

Extent | [-54.320305,35.403423)--30.513454 42 327132)

|

Type |F'|:|I_I,Ig|:|n Coordinates

Layer Mame Irdp_EIZII:IEI_SEI_sIdI_VED

I™ Import layer
¥ | Eliminate duplicate boundan lines

| areas averlap
% hierge the overlap with one of them
£ Create anew area
£ haintain overlapping areas
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9.  Close and re-open the VTD Editing toolbox.

10. Now the layer added is a layer selection in the Layers dialog box.

layers x|
Layers in Order of Dizplay Sample Status
Current SLD Upper [St... ;I
Current CO [Statewide] Hidden
SLD Lower LT Hidden _ Hide Layer |
o H
SLO Upper e Hidden Add Laer
Congressional District o Hidden —
) Drop Layer
Foint Landmarl: * Autozcale _—
Al Lines — Autoscale tave Lp
fave Dawn
Style. .. | Labels... | Autozcale... | wl
Geographic File ||:Z"-....|:I_|,I|E|:||:||:|1 WDezkiopiWTO-BESPYdp_2003_39 zld| »30. shp

11. Change the Styles of borders, fills, etc., in the Layers dialog box. Set the style to a
symbology that is conducive to seeing the local VTD boundaries superimposed on
the file. A Border Style with a dashed symbology, Border Color of red, and
Border Width of 1.5 is one suggestion.

12. Set the labels to identify the VTDs by clicking on Labels. Scroll to Precinct on the
Field drop down menu; on the Position drop down menu select Centered; select
the Arial Font at Size 16 Bold is one suggestion.

13. Click Apply.

Note: When adding an external file (a local GIS file, table, or imagery) to the MTPS
project, it is essential not to move the file from the location from which it was
added. To do so will cause the application to not open since it is not able to find
the added file and “crashes”.

Therefore, it is important to either remove the added local file from the layers
before closing the application or be certain to not move the file's location and be
sure to have any needed network connections to the file's location when re-
launching the application.

J. Using a Block Equivalency File (BEF)

The MTPS has a function to create VTDs from a BEF. For verifying VTDs, the
Census Bureau does not recommend using this function as it will likely result in
more work.
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The following sections in regards to the BEF are more for information purposes only.

Only use this approach if VTDs are maintained using Census tabulation blocks. If using
this process, more accuracy is achieved when using the most current Census blocks to
compile the BEF. As the MTDB is updated with new legal boundaries (for example,
incorporated place limits) or with new streets and roads, the Census 2000 tabulation
blocks are divided into smaller blocks through a process called “block suffixing.” For
example, a Census 2000 tabulation block number of 1004 may now be divided into
smaller blocks that are numbered 1004a, 1004b, and 1004c. These “current” blocks have
been provided in public TIGER/Line products over the years. If the block in the file is
“1004,” and does not contain the current suffixes, the MTPS does not associate a VTD
code to the suffixed blocks. Find and fix these areas during a VTD editing session using
the MTPS, as described in Section I.H. The VTD Editing Toolbox.

To correct VTDs with a BEF that is maintained in the local GIS or database application,
select Import Equivalency from the Area Settings: Voting District box, when opening
the county of the VTDs to correct.

Area Settings: ¥oting Dis il

Settingz

™ Start with existing features
" Create empty layer

= |mport E quivalency

k. I Cancel

Click OK.

The Choose File to Import box appears: (The MTPS only supports the following file
types: .bin, .txt, .csv, .dbf, .asc.)

Choose File To Impork 21xl
Laok if: I@ Diesktop ;I & B cr B

BMY Document ks
-j My Cormnputer
[y Metwork Places
| “)Meed paper maps
| ==)5tate Relationship Info sheets
|22 TH MED Files
| 2iTsaP
| )WTD-EESP 2010

zorn0o01 from Atlas
[}z BEF for Testing.dbf
S 5 Sharteut to public on 'geoid’ (V)

File name: IAZ_BEF_fur_T esting. dbf LI Open I
Files of type: | dBASE file [*.dbf) =l Cancel |
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Choose a file and click Open. MTPS displays the Import Block Equivalency File
dialog box. Choose the field from the BEF which matches the block field from the
Match Block Field To dropdown list and the field which contains the district code from
the Fill District From dropdown list, then, click OK. Each field in the state's block
equivalency file should have a descriptive name such as BLOCKID and DISTRICT.
This makes it easier to identify and select the Match Block Field To and Fill District
From fields when using the importer. If the fields are not given a name, the first record
in each field appears in the drop down lists as the field names.

Import Block Eqivalency File ﬂ

File |E:'\DDEUMENTS AMD SETTIMGS'20RMNOOMADE ... |

Fill Diiztrick From IDISTHIET LI

k. I Cancel |

Block Equivalency File Format

In order for the match to work, the state BEF must contain two fields in each record. The
first field (named BLOCKID in the graphic below) contains concatenated state, county,
tract and block codes. If using current blocks there may be an additional block suffix
appended at the end of the block code (as appears in the SUFFIX1 column below). For
example, BLOCKID appears as 110010001001001, where the 11 is the state FIPS code
(STATEFP in the example below), 001 is the county FIPS code (COUNTYFP below),
000100 is the TRACT number and 1001 is the BLOCK number. If the block is suffixed,
the BLOCKID appears as 110010001001001A, containing the additional A, as shown in
the SUFFIX1 column below. If the BEF currently shows those geographic areas as
separate fields, concatenate them into a single field before performing the import. The
second field is the VTD_CODE.

In the example below the BLOCKID field is used in the Match Block Field To pull
down menu. The VTD_CODE is used in the Fill District From pull-down menu.

STATEFP | COUNTYFP | TRACT | BLOCK | SUFFIx1 SUFFIX2 BLOCKID vTD_CODE
18 015 959300 (3035 o 1801359593003035.L (024555
18 015 959300 (3035 c 180159593003035C | 024555
15 15 959300 (3033 1501595935003530335 024555
15 15 8959300  |3031 1501589593500:3530351 024555
18 015 959300 (3035 B 18015959300303568 |02B555
18 015 959300 (3034 o 18015959300353034.8  |02B555
15 15 959300 (3034 B 1501585930050346B |02B555
15 15 959300 (3032 1501595935003530352 028555
15 013 959300 |30249 1501 3838300353029 028335
18 015 959300 (3030 180159593003030 028555
18 015 959300 (3035 [n] 1801595930030350 |02B555

Once the import is completed, the MTPS fills the county based on the VTD codes
included in the local file. However, as mentioned before, if the block record in the local
file does not contain the current suffixes (if that block has been suffixed), that block does
not fill with a VTD code.
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Each VTD appears highlighted in a different color to distinguish adjacent VTDs.

1. Find and fix any unassigned or non-contiguous areas using an editing session as
described in Section I.H. The VTD Editing Toolbox.

2. Review the boundaries of these VTDs. This is a very important step. Make sure
that each VTD is following the correct feature. The Census Bureau’s MTDB has
changed significantly since Census 2000 and this can affect the feature to VTD
relationship.

3. Click 2% in the VTD Editing toolbox to display the Attributes dialog box to
correct the Code, Name, Relationships, or the Pseudo (VTDI) assignment. Note
that the existing VTD must be selected in the Target Area dropdown menu of the
VTD Editing toolbox.

4. To correct (or create) a VTD using these VTDs as a starting point (for example,
create two “new” VTDs from one existing VTD), select New District in the Target
Area dropdown menu.

K. Reviewing and Correcting BBSP Submissions

As part of the VTD/BBSP verification, review each county (or county equivalent) for the
correct flagging on features to hold (Must Hold) as 2010 Census tabulation block
boundaries or linear features to not hold (Do Not Hold) as block boundaries as being
correct.

Note: All Must Hold block boundary suggestions are contingent upon the lines
intersecting to form a closed polygon at the time the Census Bureau creates the
2010 Census tabulation blocks, which occurs in the fall of 2010. For this reason
all block boundary suggestions must form a closed polygon with other planned
block boundaries.

Note: If any other program sponsored by the Census Bureau flags a line as a Do Not
Hold as a block boundary, on a BBSP Must Hold, the Census Bureau overrides
the (other program) Do Not Hold status of the line.

Review and verify that any Block Area Groups (BAG) are correct.

L. Planned 2010 Census Tabulation Block Boundaries

The list below specifies the entity boundary description and the MAF/TIGER Feature
Classification Code (MTFCC) that are currently planned as 2010 Census tabulation block
boundaries.

It is not necessary to suggest any MTFCC on this list as a Must Hold.

Note: It is not allowed to suggest any of these MTFCCs as a Do Not Hold.
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Entities: The boundaries, as of January 1, 2010 for each of the entities listed below are
planned 2010 Census tabulation block boundaries and therefore do not have to
be suggested as part of the BBSP work.

MTFCC Description

G2120 Hawaiian Home Land

G2130 Alaska Native Village Statistical Area
G2140 Oklahoma Tribal Statistical Area
G2150 State-designated Tribal Statistical Area
G2160 Tribal Designated Statistical Area
G2170 American Indian Joint Use Area
G2200 Alaska Native Regional Corporation
G2300 Tribal Subdivision

G2400 Tribal Census Tract

G2410 Tribal Block Group

G4000 State or State Equivalent

G4020 County or County Equivalent

G4040 County Subdivision

G4060 Sub-Minor Civil Division

G4110 Incorporated Place

G4120 Consolidated City

G4210 Census Designated Place

G5020 Census Tract

G5030 Block Group

G5035 Block Area Grouping

G5200 Congressional District

G5210 State Legislative District (Upper Chamber)
G5220 State Legislative District (Lower Chamber)
G5240 Voting District

G5400 Elementary School District

G5410 Secondary School District

G5420 Unified School District

G5430 Special School Administrative Area
G6320 Traffic Analysis Zone

G6330 Urban Growth Area

K2110 Military Installation

K2181 National Park Service Land

Features: The features listed below will qualify as 2010 Census tabulation block
boundaries based on criteria. Those that qualify are shown in red in the
MTPS. All others are available for selection except for those shown in blue.

MTFCC Description
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S1100 Primary Road

S1200 Secondary Road

S1400 Local Neighborhood Road, Rural Road, City Street
S1500 Vehicular Trail (road passable only by a 4 wheel drive)
R1011 Main Line Railroad Feature

P0002 Perennial Water

Note: Feature extensions and powerlines are not planned to be held as 2010 Census
tabulation block boundaries (unless they are also the boundary for one of the
entities listed above), but they are eligible to be selected as a Must Hold.

To see a complete list of all MTFCCs (previously referred to as Census Feature Class
Codes [CFCCs]), see Attachment D: MAF/TIGER Feature Classification Codes.

M. To Navigate the BBSP Map

From the Standard menu, select VTD/BBSP—~>BBSP Toolbox.

2
[ @[] P[] 1] o] o]

" Hold  DoMotHold € Mone

Use the following buttons in the BBSP toolbox:

To zoom to... Do this...

The entire map Click @ The MTPS zooms to show the entire map.

The current suggestion Click ﬂ The MTPS zooms to show the current block boundary
suggestion.

Also use tools in the Tools toolbox to navigate around the map.

N. To Review and Verify Census 2010 Must Holds and Do Not Holds

Use the MTPS to review and verify any state submitted features identified as Must Hold
or Do Not Hold. To do this, follow these steps.

1.  Click the Display Settings icon |!|
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3.

BBSF Display

— Settings

[+ Display Holds
[+ Display Do Mot Haolds
[+ Display Planned

[+ Display Ineligible

[+ Use BESP display settings for |2EI‘IEI "I

v Dizplay Feature Extensions

| ok |

Click OK. Inthe Map layers, the 2010 Hold Status displays

MMap layers
B e WTD
e mrea Landrmark
River, Lake, or Ocean
[ 1 Faces
Census Tract
2 2o MCD
oty
B state
LI I Incorporated Place
% % Census Designated Place
WTD 2000 (Statewide)
#*  Point Landmark
— All Lines
Area Landmarks
area Landmark: Park
Area Landrark: pilitary
L4 mrea Landmark: Other
2010 Hold Status
— lLst Hold
— Do Mot Hold
Plarmned Hold
fee: [112ligibnle for Hold
Feature Extensions

[w] #5000
L 1

Feet

Use the Info tool @) to determine the current BBSP values, following are the

current values:

e 2010BBSP =1:

e 2010BBSP = 2:

e CBBFLG=4:

e CBBFLG=9:

Participant Suggested Census 2010
Must Hold

Participant Suggested Census 2010 Do
Not Hold

Planned 2010 Census Block Boundary

Ineligible 2010 Census Block Boundary
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3.

To Change BBSP Display Settings

Clickﬂ in the BBSP toolbox to display the BBSP Display Settings dialog box.

Make changes as follows:

To do this... Do this...

Use all of the display settings Check Use BBSP display settings and make sure that all of the items
are checked

Use some of the display settings Check Use BBSP display settings and make sure that the items you
want to use are checked

Use none of the display settings Remove the check from Use BBSP display settings

Click OK.

The MTPS redraws the map to use the display settings chosen.

P.

1.

To Review BBSP Suggestions

All BBSP suggestions can be reviewed and verified, including those entered for this
verification session. Enter a choice as follows in the BBSP toolbox:

To do this... Do this...
Review Must Hold suggestions Click the Hold radio button
Review Do Not Hold suggestions Click the Do Not Hold radio button

When the BBSP toolbox is open, the MTPS shows the count of all suggestions and
the position of the current suggestion within that count. The MTPS activates the
navigation buttons as appropriate.

Use the navigation buttons as follows:

Click... To zoom to the...
H First suggestion

4 Previous suggestion

4 Next suggestion

M ‘ Last suggestion

The MTPS zooms in on the map to show the suggestion. Also click ﬂ to zoom to
the current suggestion.
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Note: To review BBSP suggestions added in the verification session, click to the
last suggestion and review backwards. The first suggestions in the tool are
the suggestions entered in the submission phase.

Q. To Correct BBSP Suggestions

To enter any corrections to the submitted BBSP suggestions, follow these steps:

1.

Make a choice as follows in the BBSP Toolbox:

5
e ] I K R N

& Hold ¢ DoMotHold ¢ Maone

To do this... Do this...

Make Must Hold suggestions Click the Hold radio button

Make Do Not Hold suggestions Click the Do Not Hold radio button
Clear suggestions Click the None radio button

Click /] to activate the Select feature tool.

Click on one or more line features. The MTPS displays a warning message if a
suggestion is not appropriate or if clearing a Must Hold or Do Not Hold
suggestion.

If the correction involves entering a Must Hold suggestion for a line feature
marked Ineligible, it is required provide imagery to re-classify the feature. Attach
an imagery file or reference an image on the Internet by providing a URL. The
MTPS displays the Ineligible BBSP Feature dialog box.
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Ineligible BBSP Feature x|

— Settingz

That segment has been clazsified as being inelgible to be held for a block boundary unless
an image file can be enclosed, or a reference provided to a an image at a publicly
accessible web address, that verifies the line az a valid feature.

¥ Leave unmarked
i~ Encloze image file

File | [

" Reference image URL

(TR |
Cancel | k. I
Enter choices as follows:
To do this... Do this...
Leave the line feature unmarked Click the Leave unmarked radio button
Enclose an image file Click the Enclose image file radio button or click J and either

type a file name or choose an image file, and click OK.

Provide URL Click the Reference image URL radio button and type a URL

Note: When applying a Must Hold to a feature extension that is designated as
ineligible for selection, enter the word EXTENSION in the URL box when
prompted for imagery.

Note: To use a TerraServer USA image, follow the instructions in Section Il.A.
Importing Digital Imagery from TerraServer USA and save the image on the
local hard drive. Then Enclose an image file as instructed above.

5. Iftrying to add a Do Not Hold suggestion for a line feature marked as a Planned
Hold, the MTPS displays a Note:

Note x|

\ll) This recard is planned ta be held for a block boundary in 2010,

K |

Click OK.
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R.

Note: Remember that the boundary of each governmental entity (or statistical
entity)” is held as a 2010 Census tabulation block boundary as are most
roads. Private roads, trails, and unimproved roads may or may not be held
and therefore are more eligible for a Do Not Hold suggestion.

Feature Extensions

To form a closed polygon, a short line feature extension may be added. Requirements for
feature extensions are:

no longer than 300 feet;

straight lines from the end of a road and intersecting a non-road feature. These
include all hydrographic features, pipelines, powerlines, and railroads. Highways
and freeways are acceptable as long as it is confirmed that there are no housing
units on them. This situation has the potential for causing a housing unit to be in
the wrong Census 2010 tabulation block.;

not intersecting a cul-de-sac.

Verify that the submitted (approved) feature extensions are correct.

To create a new feature extension, add the line as described in Section I.LE. To Add a

Line.

S.

Dividing Large Water Blocks

If during verification it is necessary to add a line to divide large water blocks for the
BBSP program, add the line and assign an MTFCC of P0002. Also assign a Must Hold
status to the line.

T.

To Verify any BBSP Flagging, Unassigned, and Non-Contiguous
VTDs

From the top menu choose VTD/BBSP->Verify. The MTPS performs the tests.
These tests include checking for noncontiguous and unassigned areas and closed
polygons for Must Hold selections.

If the test fails for noncontiguous or unassigned areas, the MTPS displays an
appropriate message. Review these areas by choosing from the top menu,
VTD/BBSP-> Find non-contiguous areas or Find unassigned areas. A message
appears to open VTD Editing toolbox.

If the test fails for closed polygons, the MTPS displays the List Unclosed Polygons
dialog box. Enter choices as follows:

®i.e., Census tract, Census Designated Place
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To do this... Do this...

Zoom to unclosed polygons Highlight one or more entries in the scroll list and click @

Update the list of unclosed polygons Click @ If there are no more unclosed polygons, the MTPS
closes the List Unclosed Polygons dialog box.

As needed, correct any BBSP suggestions made during the verification review
using the BBSP toolbox.

If entering any corrections, run VTD/BBSP—-> Verify again to ensure any recent
corrections are valid.

When all tests pass, the MTPS displays the message; The verification of
VTD/BBSP data was successful.

Click OK to close the message.

II. ADDING ANY LINES AND PROVIDING IMAGERY

As mentioned in the VTD/BBSP Verification Guidelines for Participants, features added
as part of the Census Bureau’s Address Canvassing Operation, which was held in the
spring/summer of 2009 are reflected in the VTD/BBSP verification products.

In verifying the Phase 2, VTD/BBSP file, if a road feature (and only a road feature) is
identified as still missing and not included in the MTDB as reflected in the verification
materials, it can be submitted to the Census Bureau to add.

Recent imagery and/or links must be provided to substantiate the road add(s). If
imagery is not provided, the Census Bureau examines all viable imagery, source,
and reference material in determining if the road candidate is added. The Census
Bureau accepts road adds and updates upon validation with requisite imagery and
source material.

The following source material may be accepted:

add imagery from TerraServer USA
include own imagery

mail or fax an image or map

provide a URL to display an image or map

Add any non-visible VTD (and other RDP boundaries, i.e., SLDU and SLDL) boundaries
for correction and label them as such.
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See Section I1.E. for instructions on adding a line.
A. Importing Digital Imagery from TerraServer USA

Microsoft Corporation maintains TerraServer USA, an on-line database of high
resolution United States Geological Survey (USGS) aerial imagery and scanned USGS
topographic maps. This can be used to submit requisite imagery for the line add(s) and to
add as a new layer in the MTPS map.

E
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R ezalutian I.ﬁ.utnscale vI

The .NET Framework must be installed to use this command; for more information, see
Download details: NET Framework
(http://lwww.microsoft.com/downloads/details.aspx?Family|D=262d25e3-f589-4842-
8157-034d1e7cf3a3&displaylang=en)

To add TerraServer USA imagery, click on Tools=> Imagery—> TerraServer USA
Toolbox. Click M to retrieve the image.

To save an image to be included in verification corrections and update, click Save and
choose Jpeg in the Files of Type dropdown menu, in the Save As dialog box. Be certain
to include the state and county FIPS codes as part of the name.

To learn more about adding imagery, see the Using Images in a Map lesson in the CBT.
Also, when activating the TerraServer-USA Image Tool toolbox, press F1 to be
directed to the on-line help documentation for that toolbox.

B. Adding Digital Imagery as a Layer

If any recent state or local digital imagery is available, this imagery can be added to assist
in the verification review. To add any state or local digital imagery as a layer, use the
Add a Layer function as described on page 13. The imagery must be in a geo-referenced
format to export the image into a format that can be read by the MTPS. These can be
seen by using the Add a Layer function and then using the File Type pull down menu.
Be sure to include the state and county FIPS code as part of the name.

C. Mailing or Faxing an Image or Map

To provide an image or a map to show that a feature does or does not exist, mail or fax it
to the respective RCC office.
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Be certain to clearly reference the image or map (i.e., image or map #)°® with the specific
large scale location of the line add in the specific state and county (or county equivalent).
Include a contact person and e-mail and/or telephone number in reference to the image or
map. The RCC may be in contact if there questions regarding the line add.

To provide information for a deleted line, the image or map must clearly show that a line
no longer exists. When selecting the line for deletion, provide an explanation in the Add
a Comment box that appears and reference the image or map that has been mailed or
faxed to the respective RCC.

D. Providing a URL to Display an Image or Map

To supply a URL to display an image or map, include the URL, state and county (or
county equivalent) and FIPS code and e-mail it to the respective RCC. Be clear to
reference the state and county (or county equivalent) and the location of the specific line
being added.

When providing URLS to existing imagery, provide the full path to the specific imagery
that contains a close up of the feature or area being revised or added. The Census Bureau
requests this to increase the likelihood to accept the changes and corrections identified by
the participant for verification. Be certain to clearly reference this link with the large
scale location of the line add in the specific state and county. Include a contact person
and e-mail and/or telephone number in reference to the image or map. The RCC may be
in contact if there are questions regarding the line add.

After requisite imagery, map and/or other source material is provided, the line can be
added during the verification process.

E. ToAddaLine
To engage the Line Editing tool, select VTD/BBSP-> Line Editing Toolbox.

The Line Editing tool appears.

4
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Any line added too close to existing lines may not be accepted. To avoid this problem it
is highly suggested to use existing lines, if possible, when delineating VTD (or other
RDP) boundary lines. If an added line repeatedly intersects or is within 10 meters of
another line, the MTPS prompts to use the (close) existing line.

® This is more paramount when submitting multiple images and/or maps.
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x

WwhARMING
The new line interzects line 23447 in 2 locations.
The new line interzects line PE314 in 2 locations. Can you uze
the existing lines ingtead?

Yes I Mo I

The line numbers in the above Confirm box are called line IDs. If the line has no name,
only the line ID is listed. To review the referenced line, follow these steps:

e Make a note of the numbers in the box.
e Click Yes. (The line just delineated is not added to the map)

e Make sure that All lines appears in the drop down menu on the Standard toolbar
at the top.

e Click on the Dataview Icon

e Click on Edit in the Standard menu at the top.
e Click Find.

e Type in the number in the Dataview Find box.
e Click OK.

e Right click on the Record ID.

e Select Zoom.

MTPS zooms to the line. Hover the cursor over the line, a box appears with the line ID
number.

If a line is within 15 feet of a Census provided line, do not add it. Lines added within 15
feet of an existing line are not added (inserted) during the verification phase of the
VTD/BBSP.

The steps for adding a line for VTD/BBSP correction are as follows:
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Choose from the top menu, VTD/BBSP—> Line Editing Toolbox. The MTPS
displays the Line Editing toolbox.

Click 4| to activate the Add Line tool.
Click where to start the line.
Move the cursor and left-click to create shape points along the new line.

Note: When digitizing shapepoints, if the line intersects any existing line, enter a
shape point (left-click) precisely at the point of intersection. This precludes
a segment from snapping to other existing nodes (vertices) when digitizing

completes.
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lLes End point (at intersection)

/ Start point (at intersection)
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curve points

Caril oy

5. Besure to zoom in sufficiently to see that the end point is connected to another line
to form a closed polygon.

Note: To end the digitizing of a line without actually creating the line started, hit
the Esc key.

6.  To finish the line, double-click to end it. (Click at a node [either at an intersection
or at the endpoint of a line], on a line, or in space.)

The MTPS adds the new line and displays the All Lines — Editing Attributes
dataview box.
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If the line is too close to, or intersects another line, the MTPS displays the Confirm
dialog box.

x

WARMNING
The new line interzects ine 23447 in 2 locations.
The new line intersects ine ¥65314 in 2 locationz. Can pou uge
the exizting lines instead?

Yes | Mo I

Follow the instructions above to review the suggested lines.
If it is not desired to use an existing line, see the following note.

Note: For adding lines in tight topology, lower the snapping distance. Choose
from the top menu, Edit-> Preferences. On the System tab, change Snap
Tolerance to the distance and units desired. 10 feet is one suggestion.
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Click OK.

7. After changing the snap tolerance, re-add the line. After double clicking the end
point of the added line, the Confirm box appears.

Lag Canoa Cir

[All Lines: Laog Canoe Cir]
__.z'fz-. 1047
JI W
3 x
f ! WARNING
i The new line ig near line 5633 [Log Canoe Cir]. Can pou Lge
& the exizting line instead?
it
/%
] 3
% \ Tes | I Mo I @?&
. 4 o

SN S

Click No to use the added line.

8.  Now the Dataviewl — All lines — Editing attributes panel appears. Specify the
MTFCC for the line add. Do this by double-clicking the panel to the right of
MTFCC and select a feature type from the dropdown list. See the following
example of assigning a Local Neighborhood Road.
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e |f adding a correction line to be a non-visible VTD boundary, choose P0001
(Non-visible Legal/Statistical Boundary).

e If adding a correction line to be a feature extension, choose P0004 (Other
non-visible bounding Edge (e.g., Census water boundary, boundary of an
areal feature). See Section I.R. Feature Extensions.

9.  Click the icon to the right of FULLNAME to enter any name. See the following

example.
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If the feature added does not have a name, describe the line being added in the
FULLNAME field as follows:

e Right click in the FULLNAME field
e Add description (i.e., Section Line) and

10. Click ¥ to add the line or ] to cancel the added line. Also go to Edit=> Undo,
while still in the map window, to cancel any added saved lines.

Note: The Line Editing tool allows users to delete, split, and copy lines; edit line
attributes; and display names and address ranges. A deleted line that has been
added and saved appears as a red dashed line. For more information on this
toolbox, review the Editing Linear Features lesson in the CBT. Also, highlight
the tool and press F1.
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Note: Many pre-existing line attributes, such as addresses, are not editable in the RDP
version of the MTPS. Furthermore, in regards to address ranges, when a line is
split in the MTPS, both segments retain the original address range. The address
range “imputes” the range break in the MTDB.

I1l. IF STATE/LOCAL GEOGRAPHIC DATA ISNOT
CONSISTENT WITH CENSUS BUREAU DATA

Since the geographical data displayed in the local layer may not align exactly to the
Census Bureau MTDB file, it may be necessary to adjudicate this geography. For
example, if a VTD follows a school district boundary and the location of the school
district is different between the local file and the Census Bureau MTDB file, use the
school district boundary as aligned in the MTDB location. This situation is demonstrated
in the graphic below. If local knowledge determines that the school district boundary (or
other geographic entity boundary) is incorrect or is out-of-date, contact the Geography
Division by sending an email to GEO.redistricting.list@census.gov. Census Bureau staff
will provide the appropriate contact person, for school districts this would be the mapping
coordinator. If the boundary requires correction, work with the school district mapping
coordinator to correct the Census school district boundaries, and if agreed upon, the
change will be reflected in a later Census Bureau shapefile product.

To ensure that the VTD and the school district (or any other legal or administrative area)
boundary maintain that relationship, provide relationship information as instructed in the
Relationship Information Review document.

Census Bureau and local school district boundaries have a similar shape but are in
different locations.

I <ﬁ T

Census 5D Boundary
Local SD Boundary

‘~ *

1 0 1 2 Miles
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A. Boundary Corrections/Kinks and Distortions

The Census Bureau files sent out with the initial VTD/BBSP may have contained state,
county, and other boundary types with “kinks” and boundary distortions.

The Census Bureau has been working to correct these situations. This boundary review
and repair work will continue up until the Census Bureau creates the 2010 tabulation
blocks in the fall of 2010. Some of these distortions have been repaired in time for the
VTD/BBSP verification. In some cases, the Census Bureau has opted to “keep” the
distortion if re-alignment and coordinate enhancement actually causes the roads and
potential housing units to “move” from one governmental unit to another. In order for
the Census Bureau to enter that type of correction, confirmation from the BAS
respondent is required.

B. Boundary Corrections for Legal State, County, Minor Civil
Division (MCD), and Incorporated Place

The initial phase of the VTD/BBSP work highlighted many areas of the country where
local officials have not provided responses to the BAS. For this reason, the Census
Bureau’s legal boundary may be out of date. Many RDP liaisons have worked within
their states to raise awareness of the importance of the BAS and the Census Bureau has
acknowledged a good response to the 2009 BAS. The VTD/BBSP verification files to
review reflect the results of the 2009 BAS. The Census Bureau conducts the 2010 BAS
in November, 2009 — March, 2010. Any additions or boundary updates to legally defined
areas must be submitted to the Census Bureau as part of the 2010 BAS in order to be
reflected in the 2010 Census.

For information about the 2010 BAS, go to:
http://www.census.gov/geo/www/bas/bashome.html
Refer any questions or for further information, e-mail the BAS team at

geo.bas@census.gov. Please include the complete name of the legal entity in question, a
contact person, phone number and if possible an e-mail address.

IV. VALIDATING ANY CORRECTED VTD/BBSP

To ensure that any and all VTD/BBSP corrections and updates are complete and valid,
execute the built-in edits in the MTPS before submitting these corrections and updates to
the Census Bureau. These edits comprise identifying any unassigned areas and
noncontiguous areas.

Note: It is suggested to execute these validations even if not entering and submitting any

corrections or updates to ensure there were no inadvertent changes to the file
during the verification process.
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To Identify any Unassigned VTD Areas

To ensure that no part of a county has been left without an appropriate VTD code,
choose Voting Districts from the Edit Layer dropdown list in the VTD Editing
toolbox.

From the top menu, choose VTD/BBSP—->Find Unassigned Areas. If there are no
unassigned areas, the MTPS displays a message and does not display the toolbox.
Otherwise, the MTPS displays the Find Unassigned Areas toolbox. The
unassigned areas appear and are sorted by area size; the largest area is first on the
list.

Enter choices as follows:

To do this... Do this...
Zoom to unassigned areas Highlight one or more areas in the scroll list and click@
Update the list of unassigned areas Click @

Assign all unassigned area using the steps outlined in Section I.H. The VTD Editing
Toolbox. After all unassigned areas are assigned, click the refresh [£] icon and a
Note box appears indicating no unassigned areas. Click OK.

The MTPS closes the Find Unassigned Areas toolbox.

B.

1.

To Identify any Noncontiguous VTDs

To ensure that all noncontiguous VTDs are intentional, choose Voting Districts
from the Edit Layer dropdown list in the VTD Editing toolbox.

From the top menu choose VTD/BBSP—>Find Non-Contiguous Areas. If there are
no noncontiguous areas, the MTPS displays a message and does not display the
toolbox. Otherwise, the MTPS displays the Find Non-Contiguous Areas toolbox.

Enter choices as follows:

To do this... Do this...

Zoom to non-contiguous areas Highlight one or more areas if they are the same VTD in the
scroll list and click@

Update the list of non-contiguous areas Click @

If necessary, make any corrections by following steps in Section I.H. The VTD
Editing Toolbox. When complete, close box in the upper right corner.
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V. REPORTING ANY CORRECTIONS AND UPDATES FOR

VERIFICATION SUBMISSION

This section provides procedure on reporting any corrections and/or updates to the
Census Bureau upon completing the verification and review of the VTD/BBSP state
submission.

A. To Reportany VTD/BBSP Corrections and Updates for

Verification to the Census Bureau

To submit any VTD/BBSP corrections and updates to the Census Bureau, follow these

steps:

1.

B.

From the top menu choose VTD/BBSP-> Report Changes. The MTPS prompts a
Confirm dialog box to create a ZIP archive of corrections and/or updates to send to
the Census Bureau.

Click Yes. The MTPS creates a ZIP archive called RDP_ssccc_Return.zip (ssccc
= state and county FIPS code) and places it in the MTPS Data folder on the hard
drive of the local computer, and displays a message with the path to the archive.
Click OK to close the message.

To View any VTD/BBSP Changes and Updates After Reporting

To view any VTD/BBSP corrections and updates to report to the Census Bureau, follow
these steps:

1.

Use Windows Explorer to navigate to the folder c:\MTPSData <county subfolder>
and open the RDP_ssccc_Return.zip file.

Extract all of the files into a folder, such as c:\\Temp.

In the MTPS choose File>> Open or click £ on the Standard toolbar, choose
ESRI Shapefile from the Files of Type dropdown list, navigate to the folder to
extract the shapefile, choose a Shapefile, and click Open. The MTPS displays the
ESRI Shapefile dialog box, where the settings are correct.

Click OK. The MTPS displays a map with the verification Shapefile that embodies
corrections and updates. Return to Step 3 to open another Shapefile, or add one or
more Shapefiles to the map by:

(1) Choosing, from the top menu, Map—> Layers to display the Layers dialog
box

(2) Clicking Add Layer to display the Layers dialog box

(3) Choosing ESRI Shapefile from the Files of Type dropdown list

(4) Highlighting one or more Shapefiles
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(5) Clicking Open; The MTPS displays the ESRI Shapefile”dialog box, where
the settings are correct

(6) Clicking OK for each Shapefile; the MTPS returns to the Layers dialog box

(7) Highlighting each added Shapefile, clicking Style, and choosing a different
border color. Click Apply and OK.

(8) Clicking Close; The MTPS displays the map with the added layers

Submitting the Corrected and Updated Verification Files Using the
Census Bureau’s “Send a File Utility”

To submit the corrected and updated VTD/BBSP verification file to the Census Bureau,
upload the file through the Census Bureau’s Send a File Utility at:

https://secure.census.gov/cgi-bin/sendfile

See the letter that was sent with the verification materials from the Redistricting Data
Office (RDO). The letter provides the User name and Password.

1. Under Source Information (Local), click on the Browse button to navigate to the

RDP_ssccc_Return.zip file to send. Select the file from the Choose file window by
clicking on it. Click Open. The File to Send field now contains the file name.

Note: Only one file can be sent at a time.

In the Target Information (Remote Directory) section, select the appropriate state
from the Select a state: pull down menu.

Do not make an entry for New File Name.

Under Notify by E-mail, type the participant e-mail address in the Sender’s Email
Address field. In the Census Bureau Employee’s E-Mail Address field, enter the
appropriate RCC email address.

After filling in all the fields correctly, click on Upload. If an error occurs, Clear
and repeat the steps.

Note: If a file must be resubmitted for any reason, rename the file. If not, the
utility produces an error message. Please retain the default naming
convention of RDP_ssccc_Return when renaming it.  For example:

e RDP_42027_Return_revised.zip
e RDP_42027_Return_2.zip.
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